SYSTRAN 7
Business Translator
Premium Translator
Quick Start Guide
SYSTRAN 7
Quick Start Guide

Ref : DSK-7-QSG-BP-EN
Welcome

Congratulations on your SYSTRAN 7 purchase which uses the latest generation of language translation products from SYSTRAN, the leading supplier of translation software.

SYSTRAN 7 offers a variety of features and capabilities for the translation of text in any Windows-based application. A new common interface is always available, allowing you to perform translations between more than 50 of the world’s most common language pairs.

The software quickly yields a gisting-level translation (the ability to understand the general idea of what is written) and even better translation quality when users take the time to train the software to learn their company or subject terminology.

This Quick Start Guide will help you install and immediately begin using your new SYSTRAN 7 product. The following table summarizes the topics in this Guide and how they match your product.

<table>
<thead>
<tr>
<th>Topics</th>
<th>Page</th>
<th>Business Translator</th>
<th>Premium Translator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing, Activating, and Registering</td>
<td>2</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Managing Your SYSTRAN Account</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translating Online Using SYSTRANet</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Leveraging Your Resources Using the SYSTRAN Customization Wizard</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Building Translation Memories with the SYSTRAN Document Aligner</td>
<td>6</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Using SYSTRAN Interactive Translator</td>
<td>6</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translating Text</td>
<td>6</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Looking up a Term</td>
<td>8</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translating Web Pages</td>
<td>9</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translating Selected Web Page Text</td>
<td>10</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translating Microsoft Office Files</td>
<td>10</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translating Email in Microsoft Outlook</td>
<td>12</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Setting Your Global Options</td>
<td>13</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translation Options</td>
<td>14</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Profiles</td>
<td>14</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Using Quick File Translator</td>
<td>15</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Using SYSTRAN Dictionary Manager (SDM)</td>
<td>16</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Launching SYSTRAN Dictionary Manager (SDM)</td>
<td>17</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Adding Dictionary Entries</td>
<td>17</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Coding User Dictionary Entries</td>
<td>18</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Using SYSTRAN Translation Project Manager (STPM)</td>
<td>19</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SYSTRAN Desktop 7 Products comparison</td>
<td>26</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

For more detailed information about the use of SYSTRAN 7 features, refer to the SYSTRAN 7 Desktop User’s Guide, or click Help in the product.

Available translation features and options vary depending on the product you purchased. See pages 17-18 of this Quick Start Guide.
Installing, Activating, and Registering SYSTRAN Desktop 7

You can initiate the installation of SYSTRAN Desktop 7 using either a purchased DVD or an executable application (downloaded product) purchased online. Of course, as with all software installation, there are decisions and choices you will need to make as you proceed.

To use SYSTRAN Desktop 7 your system must meet the following minimum requirements:

- **Processor**: PC with Intel® Pentium® 1.2 GHz processor, or equivalent AMD® processor, or higher
- **Memory**: Minimum 1GB RAM (Windows XP), 2 GB RAM (higher Windows versions)
- **Disk Space**: 300 MB for base software
  - 100 MB per language pair
  - 500 MB available free space during installation plus additional space as needed to unzip downloaded product
- **Operating System**: Microsoft® Windows XP Home, XP Professional, Windows Vista, or Windows 7

You must have the following products installed on your PC to fully use SYSTRAN Interactive Translator and the SYSTRAN Toolbar:

- **Microsoft Office**: Microsoft® Office® XP, 2003, 2007, or 2010
- **Web Browsers**: Microsoft® Internet Explorer® 6.0 or later (free download available at www.microsoft.com) or Mozilla® Firefox® 2.x or later (free download available at www.mozilla.com)

Installing SYSTRAN Products

Procedures for installing new SYSTRAN products depend on the manner in which you acquired these products.

- **Installing from a Downloaded File**
- **Installing from a Packaged DVD or Backup DVD**

You will need a valid serial number to install your SYSTRAN product. If you purchased your SYSTRAN product in DVD format your serial number will be found inside the packaged DVD, and if you purchased your SYSTRAN product online your serial number will be sent to you via email. Keep your serial number in a safe place in case you need to reinstall your SYSTRAN product.

Prior to installing any SYSTRAN product you should ensure that your Windows installation is fully up-to-date. Also, if you are running a version of Microsoft Office prior to Office 2007, you should ensure that you have installed the *Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint File Formats* pack, which allows
these older versions of Office to open and save files created in the newer Microsoft Office formats (.docx, .xlsx, and .pptx). Visit http://download.microsoft.com for more information.

**Starting from a Downloaded File**

1) Double-click on the downloaded file and select a temporary extraction folder (this is not the folder where the software will be installed). The installation program will be extracted into this folder.

2) If the installation does not automatically launch, double-click the setup.exe in the extraction folder.

3) Next, refer to Completing Your Installation.

**Starting from the Packaged DVD or Backup DVD**

1) Insert the installation disk in the DVD drive. If Autorun does not start click on the setup.exe in the installer directory.

2) Next, refer to Completing Your Installation.

**Completing Your Installation**

1) Select your installation language. The installation software checks for the .NET Framework and other required software on your PC and installs whatever packages are needed.

2) Click Next on the SYSTRAN – InstallShield Wizard Welcome screen.

3) Click Yes to accept the License Agreement.

4) Enter a User Name, Company Name, and Serial Number and click Next.

5) Select Complete installation. Accept the Destination Folder and click Next.

   If you select Custom installation, check the box for each feature and language pair to install. Uncheck features and language pairs you do not want to install.

6) Click Next to initiate the installation. The progress bar shows installation status.

7) Activate and Register your SYSTRAN product (refer to Activating SYSTRAN Products and Registering Your SYSTRAN Product).

8) Click Finish to complete the installation.

**Activating SYSTRAN Products**

You must activate your SYSTRAN product to use it beyond the trial period.

- You can have more than one SYSTRAN product license active on a PC at the same time (e.g. licenses offering multiple language pairs).
Your first opportunity to activate your SYSTRAN product is at the end of the installation process.

- If you choose not to activate your product at installation, each time you start your SYSTRAN product thereafter the Product Activation dialog will display, detailing your SYSTRAN licenses and their activation status.

Click **Activate your product now** to continue. The following screen, **Product activation**, presents you with the following options: **Activate automatically** and **Activate manually**.

Three methods are in place by which you can activate your SYSTRAN software: **Automatic Activation**, **Activate by Phone**, and **Activate by Web**.

- No personal information is sent to SYSTRAN as a result of the Activation process.

**Automatic Activation**

Assuming you have an active Internet connection, when you click **Activate automatically** on the **Product activation** screen, SYSTRAN Desktop 7 will send your Serial Number and Identification Number to SYSTRAN to activate your product.

Following successful product activation the **Product registration** dialog will display.


**Activate by Phone**

Click **Activate manually** on the **Product activation** screen to display the **Activate manually** screen, which offers SYSTRAN support telephone numbers that you can call to obtain your Activation Number.

Enter the Activation Number provided over the phone into the **Enter your Activation Number** field and click **Next >**.

Following successful product activation the **Product registration** dialog will display.


**Activate by Web**

Click **Activate manually** on the **Product activation** screen to display the **Activate manually** screen, which offers a Web link that you can use to obtain an Activation Number and the field into which you will enter that number for activation.

Enter the Activation Number provided over the Web into the **Enter your Activation Number** field and click **Next >**.

Following successful product activation the dialog the **Product registration** form will display.
Managing Your SYSTRAN Account

You can easily log into and manage your SYSTRAN account via the SYSTRAN Website (www.systransoft.com / www.systran.fr). Also, once your SYSTRAN Desktop 7 product is registered you can access your SYSTRAN account information by clicking the My SYSTRAN Account section in SYSTRAN Global Options | Application Settings.

Translating Online Using SYSTRANet

If you are a registered user of a SYSTRAN Desktop 7 product, and a subscriber to SYSTRANet online translation service, you can translate online and benefit from special SYSTRANet translation features directly from your SYSTRAN Desktop 7 applications.

Leveraging Your Resources Using the SYSTRAN Customization Wizard

SYSTRAN Customization Wizard automatically uses the content of your files and emails to learn new terminology and improve the quality of your translations. It extracts and analyzes the text contained in your data and builds linguistic resources (Wizard User Dictionaries and Language Models) that will be used by your SYSTRAN Desktop 7 product to adapt the translation to your domain(s).

SYSTRAN Customization Wizard allows you to select:

- Which text to scan from any files or email folders
- The language pairs for which you want to build linguistic resources

This feature is available in all SYSTRAN Desktop 7 products. SYSTRAN Business Translator and SYSTRAN Premium Translator allow you to manage multiple configurations. A configuration records the list of resources to scan and the target language pairs. Managing several configurations allows you to adapt SYSTRAN machine translation to multiple domains corresponding to different content stored on your machine (e.g. technical, cooking).

Building Translation Memories with SYSTRAN Document Aligner

SYSTRAN Document Aligner allows you to build a Translation Memory out of a source language file and the file containing its translation.

Translation Memories (TMs) generated from SYSTRAN Document Aligner can be used via a translation profile to enhance translation in any SYSTRAN Desktop 7 product. These TMs can also be modified using SYSTRAN Dictionary Manager (SDM).

Using the SYSTRAN Interactive Translator

Translating Text

Using the SYSTRAN Interactive Translator, you can translate text from any Windows application simply by cutting/copying and pasting it into the Translator’s source text entry field. You can also type text directly into the source panel for translation.

1) Start the SYSTRAN Interactive Translator either by clicking the SYSTRAN Interactive Translator icon on your Windows Desktop, or by clicking Start > All Programs > SYSTRAN > SYSTRAN Interactive Translator. The SYSTRAN Interactive Translator appears.

2) Use the Source language dropdown to select a source language.
   - Activate automatic language detection by selecting Auto in the Source language dropdown.

3) Use the Target language dropdown to select a target language.

4) Input the text into the source text entry panel of the SYSTRAN Interactive Translator. Note that prior to being translated the input text will display in grey.

5) Click the Translate button 🌍. The translated text appears in the translated results field of the SYSTRAN Interactive Translator.
   - By default, SYSTRAN Interactive Translator is set to Translate During Typing. You can change this setting via the toggle setting or with the SYSTRAN Global Options dialog.
Shortcut

Enter text to be translated in the source text entry field of the SYSTRAN Interactive Translator.

Press **Ctrl+Shift+T**. The translated text appears in the translated results field of the SYSTRAN Interactive Translator.

You can change the keyboard shortcut via the **SYSTRAN Global Options** dialog, and if you are using Firefox you may want to do so to avoid conflicts.

To aid in evaluating your translation, once results are present in the SYSTRAN Interactive Translator terms and sentence highlighting is applied in accordance with the **SYSTRAN Global Options** settings indicated in **Application Settings|SYSTRAN Interactive Translator|Text highlighting**.

Looking up a Term

You can look up a term in any of your installed dictionaries using the SYSTRAN Interactive Translator.

1) Click the SYSTRAN Interactive Translator icon on the Desktop, or click Start > All Programs > SYSTRAN > SYSTRAN Interactive Translator. The SYSTRAN Interactive Translator displays.

2) Ensure that the correct source-target language combination is set for your term lookup, and if necessary make the appropriate changes using the SYSTRAN Interactive Translator’s Source Language and Target Language dropdowns.

3) Enter the term whose definitions you want to learn into the Dictionary Lookup text entry field on the SYSTRAN Interactive Translator.

4) Type the term directly into the text entry field.

   -- or --

   Highlight the term in either the source text or the translated results field.

5) Right-click and select **Lookup** from the context menu.
SYSTRAN 7 – Quick Start Guide

6) Click the **Lookup** button 📚 to the right of the field. Lookup results will display in the SYSTRAN Interactive Translator’s **Lookup** results field.

SYSTRAN 7 provides a great deal of information in the list of meanings for a Lookup term. Each entry may include information about the domain, usage, language level, and grammatical category of the entries. Refer to Codes for Lookup Results for more information on the codes that may display in your Lookup results.

**Translating Web Pages**

The SYSTRAN Toolbar is integrated into your Web browser when you install SYSTRAN Desktop 7. By default, this Toolbar appears when you open the browser. To hide it, select the **View|Toolbars|SYSTRAN Toolbar 7** menu command. To redisplay it, repeat this procedure.

If you want to move the SYSTRAN Toolbar (Internet Explorer only), you must first unlock the browser toolbars. Select the **View|Toolbars|Lock the Toolbars** menu command to remove the checkmark next to it.

1) Use the browser to navigate to a Web page. If Automatic language detection is enabled, the detected language will automatically appear in the **Source language** dropdown.

2) Use the **Source language** dropdown to change the selected source language.

3) Use the **Target language** dropdown to select a different target language.

4) Click the **Translate** button to display the translated page.
Use the Translation Options dialog box to specify if the translated page should appear in a new window or in the original window. In Firefox, you may also display the translated page in a new tab.

Translating Selected Web Page Text

You can use the right-click context menu to translate selected text on a Web page.

1) Set your source and target languages.
2) Select text to translate.
3) Right-click the selected text and select SYSTRAN Translate from the popup menu.
4) A translation of the selected text appears in the lower right of the Desktop.

Translating Microsoft Office Files

To translate Word documents, PowerPoint presentations, and Excel spreadsheets:

1) Open the document, presentation, or spreadsheet you want to translate.
2) If Automatic language detection is enabled, the detected language will automatically appear in the Source language dropdown. Use the Source and Target dropdown lists to change the source or target language.
3) Click the **Translate** button on the SYSTRAN Toolbar, or click the right mouse button to open a popup menu for additional translation options. The translated file appears in a new window as a read-only file. You can save the translated file using the standard Windows **File**, **Save** function.

**For Office 2007 and Office 2010:**

1) Click the **SYSTRAN** tab to reveal the **SYSTRAN** tab group in the ribbon.

2) If Automatic language detection is enabled, the detected language will automatically appear in the **Source language** dropdown. Use the Source and Target dropdown lists to change the source or target language.

3) Select a Profile to apply for the translation.
4) Click the **Translate** button droplist in the tab group and indicate **Translate Document**.

The translated file appears in a new window as a read-only file. You can save the translated file using the standard Windows **File|Save** function.

### Translating Email in Microsoft Outlook

When SYSTRAN Desktop 7 translates an email, the source (original) text and target (translated) text appear in a revised email, separated by a banner.

1) Open Microsoft Outlook.

2) Open a message that you want to translate, or type a new message.

3) Use the **Source** and **Target** dropdown lists to change the source and target languages.

4) Click the **Translate** button. SYSTRAN Desktop 7 translates the email, inserts the translated text into the same email as the source text, and places a banner between the two versions.
If you are using Word as your email editor, you will see a new email message with the translated text when you click **Translate**, and not the split-panel display illustrated above.

**For Office 2007 and Office 2010:**

Unlike other Microsoft Office 2007 applications, Outlook 2007 maintains the layout of menus and toolbars utilized in previous versions. It is only at the actual email level that Office 2007’s characteristic Tab-Ribbon design comes into play.

1) Open an email that contains text you want to translate, or start a new email and enter text to be translated.

2) Click the **SYSTRAN** tab to reveal the **SYSTRAN** tab group in the ribbon.

3) Use the **Source** and **Target** dropdown lists to change the source and target languages, as necessary.

4) Click the **Translate** button droplist in the tab group and indicate **Translate Document**. SYSTRAN Desktop 7 translates the email, inserts the translated text into the same email as the source text, and places a banner between the two versions.

   -- or --

Highlight a portion of the email you wish to translate, then click the **Translate** button droplist and select **Translate selection** to translate the selected text.

   -- or --

Click the **Translate** button droplist and select **Translate selection and replace**. SYSTRAN Desktop 7 translates the selected text and replaces the source text with the translated text.

**Setting Your Global Options**

The **SYSTRAN Global Options** dialog box includes three tabs: **Application Settings**, **Translation Options**, and **License**. The options available on each tab depend on the SYSTRAN Desktop 7 product you have installed.

- Each tab has a tree view of option settings in the left panel.
- Each section in the tree view can be collapsed or expanded.
- Select an option in the left panel to display its settings in the right panel.
Translation Options

The Translation Options tab allows you to control how SYSTRAN Desktop 7 translates your files. Settings are organized in categories, and individual settings depend on the SYSTRAN Desktop 7 product(s) installed and activated on your PC.

Profiles

Translation Option settings can be saved in Profiles, allowing different users to select their own preferred options when working with SYSTRAN V7 products. User Profiles can be saved, exported and imported.
When a Profile is selected, all options associated with that Profile are loaded. If no profile is selected, SYSTRAN V7 will use the default Option settings.

**Creating a Profile**

1) Click the **New** button to open the **New Profile** dialog box. Enter a name for the new profile in the **Profile name** field. Also, if the Service for the profile is to be of a remote nature, specify it using the provided dropdown and click OK. Enter a name for the Profile and click **OK**. The new profile name will display in the **Profile list box**.

2) Enter Translation Option settings for the new profile.

3) Click **Apply** to save the new profile, or **OK** to save the new profile and exit the **SYSTRAN Global Options** dialog.

**Using Quick File Translator**

Available with SYSTRAN Business Translator and SYSTRAN Premium Translator, SYSTRAN Quick File Translator is a quick and easy way to translate PDF, TXT, Word, RTF, Excel, PowerPoint, or HTML files directly from Windows Explorer.

- [Translating a Single File](#)
- [Translating all Compatible Files in a Folder](#)

**Translating a Single File**

1) Open the Windows Explorer and locate a file to translate.

2) Right-click the filename to open the popup menu.
The popup menu will only show the SYSTRAN Translate option when you right-click on a supported file format.

3) Select **SYSTRAN Translate**. A **Save File As** dialog box will display.

4) Select a Source and Target language.

5) Select a Profile to apply for the translation.

6) Click **Browse** to select a location for the translated file. The default is to place the translated file in the same location as the original file.

7) Click **Translate** to begin the translation process. A dialog will show translation progress. When the process ends, the dialog will indicate if the translation was successful or if an error occurred.

8) Click the window to open the translated file in the appropriate Windows application.

**Translating all Compatible Files in a Folder**

The Quick File Translator can translate all of the compatible files in a folder:

1) Open the Windows Explorer and locate a folder to translate.

2) Right-click the folder to open the popup menu.

3) Select **SYSTRAN Translate**. A **Save File As** dialog box will display.

4) Select a Source and Target language.

5) Select a Profile to apply for the translation.

6) Click **Browse** to select a location for the folder of translated files. The default is to create a new folder at the same level as the original.

7) Click **Translate** to begin the translation process. A Progress dialog will show translation progress. When the process ends, the dialog will indicate if the translation was successful or if an error occurred.
Using SYSTRAN Dictionary Manager (SDM)

SYSTRAN Dictionary Manager (SDM) lets you create, and maintain User Dictionaries (UDs), which can be used to customize and improve your translations.

Dictionary resources can be used for a number of functions, including:

- Translating terms not found in the SYSTRAN Main Dictionary.
- Overriding the target-language meaning of a term in the SYSTRAN Main Dictionary to customize translation output.
- Ensuring that a multi-word expression is always treated as a single unit by the translation software.

Launching SYSTRAN Dictionary Manager (SDM)

Double-click the SYSTRAN Dictionary Manager icon on your Desktop, or click Start on the Windows Taskbar and select All Programs >Systran> SYSTRAN Dictionary Manager.

Adding Dictionary Entries

UDs include three types of terms:

- Multilingual terms
- Do Not Translate (DNT) terms that should not be translated
• Source Category terms, used to specify the grammatical category of source terms without specifying their translations

After you specify the properties for a UD, you can add source and target language terms to it.

1) Click your cursor in an open box in the **Source** column. Enter the term to be translated.

2) Move the cursor to the **Target language** box on the same row and enter the target language term.

3) Click in the **Category** box to display the **Category** dropdown and select the grammatical category of the word (noun, verb, etc.). You can allow SDM to select a category automatically by selecting **Auto** (refer to **Coding User Dictionary Entries**).

4) Enter data in any other editable columns.

**Coding User Dictionary Entries**

Use the **Code Selection** and **Code All** commands in the **Dictionary** menu to check the syntactical accuracy of your UD translations against the SYSTRAN Linguistic Resource database.

**Coding an Individual User Dictionary Entry**

1) Click in any field in the record that is to be coded.

2) Select **Code Selection** on the **Dictionary** menu or click the **Code Selection** button on the toolbar to begin the coding process and display the results.

Display **Confidence** as a UD column by checking the box in the **Dictionary Columns** toolbox. The Confidence feature measures and displays the level of confidence the software has in the accuracy of coded User Dictionary entries. **You should validate any entry that shows a low confidence level.**

3) Double-click the gray box at the far left of an entry to check its confidence level. SDM will check the entry, and the length and color of the bar in the **Confidence** column show the confidence level of the entry. A confidence symbol also appears in the **Status** column next to the entry.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>The coding of the entry is evaluated as good by IntuitiveCoding.</td>
</tr>
<tr>
<td>✔️</td>
<td>The coding of the entry has been validated through ExpertCoding. This is the highest level of validation.</td>
</tr>
</tbody>
</table>
Symbol | Description
---|---
⚠️ | The target language entry does not correlate well with the source language entry or a term is unknown or seems irregular to IntuitiveCoding. A message appears in the Status Bar of the SDM screen. The entry will be used in the translation, but will probably require additional coding to work as expected.
❌ | SDM cannot find any correlation between the source and target language entries or a term cannot be coded at all. The entry will not apply in the translation and needs to be corrected.
SSID | Not yet coded.

4) If the bar is short, the software has little confidence in how the entry is coded. To increase the confidence level, revise your source and/or target language entries, and then repeat step 1 above to measure the revised confidence level.

**Coding All User Dictionary Entries**

1) Click in any active field in the dictionary.

2) Select **Code All** on the **Dictionary** menu or click the **Code All** button on the toolbar to begin the coding process and display the results.

A **Save** operation automatically codes the entries in the active UD, updates all Dictionary columns, and saves the UD.

**Using SYSTRAN Translation Project Manager (STPM)**

SYSTRAN Translation Project Manager (STPM) is a “translation workbench” that you can use to create, manage, and refine localization projects. You can run machine translations, build translation resources, and review and post-edit text using the powerful tools that STPM puts at your disposal.

With STPM you can perform side-by-side comparisons between original and translated documents and affect changes to both. As you perform your reviewing tasks you can easily fine-tune dictionaries and update Translation Memories in order to achieve both greater dictionary customization and highest-possible-quality translations.

You can greatly enhance the value of your translations with STPM, using it to add terms to User Dictionaries (UDs), and to process dictionary updates. In addition, the software offers a selection of powerful built-in review tools, including terminology review, analysis of the original document, full sentence review, use of alternative meanings, and other advanced features.
How Does STPM Work?

An STPM Project is defined by its indicated language pair, its related document files (source, target), and by a number of STPM-specific elements. It can consist of just a single file, or multiple files within a large Project comprised of hundreds of files and elements. In addition, any accessible file of a supported file format can be included in an STPM Project, as can Web documents obtained via an input Web address (URL).

SYSTRAN Premium Translator provides multiple file capability within STPM, while SYSTRAN Business Translator use is limited to single files.

In STPM, the files that comprise a Project are not actually source and target files, but are instead non-WYSIWYG simplified mirrored versions of those files. This attribute frees you from document-related concerns (such as file formats), enabling you to concentrate on the translation tasks at hand. Then, once work on the files is completed, these simplified files are transformed back to their native file format when they are exported. Another key benefit of this methodology is that all actions taken on files within STPM are separate from the original source files, which thus remain intact.

The functionality of STPM rests on XLIFF (XML Localization Interchange File Format, developed by OASIS Consortium), an XML-based format that separates localizable text from formatting, enables multiple tools to work on source strings and add to the string data, and stores information that is helpful in supporting a localization process.

Exploring the STPM User Interface

The SYSTRAN Translation Project Manager is a Windows application that incorporates such standard Windows elements as the Menu Bar, Toolbars, and the Status Bar. By default, STPM employs a two-panel layout, with the Corpus Explorer at the left and the Document Viewer at the right.
The **Corpus Explorer** offers a tree-style view of the open Project, serving as the point from which source Project documents are selected for display in the Document Viewer.

The **Document Viewer** is the true “workbench” area in STPM. When a Project source document is selected in the Corpus Explorer a non-WYSIWYG simplified mirrored version of it displays in the Document Viewer, and it is on this version that all translation review and customization is performed.

With STPM, you can have multiple Project documents active at the same time. In this event, the documents are presented in the Document Viewer as tab selections by default.

The software also offers a grouping feature that you can use to simultaneously view multiple files.

You can use STPM’s **Context Action** pane to affect single instances of text in a document file. Its functionality is in contrast to the more pervasive changes that can be made using STPM’s six (6) review panes; changes that can affect an entire document file, a selection of document files, or even your entire SYSTRAN installation.

By default, the **Context Action** pane does not display on the STPM screen at initial startup. You open it by selecting the **View»Context Action Pane** command, and once it is present it remains in place until actively closed.

**Performing Translations**

At any time while using STPM you may translate or retranslate your entire Project, a subset of Project documents, or a subset of Project document paragraphs. There are four different ways to access translation commands, including:

- Selecting the desired command from the **Translate** menu
- Clicking the **Translate** button on the **Project** Toolbar
- Highlighting the file(s) you wish to translate and then selecting the desired **Translate** command via the right-click menu
- Via `Ctrl+Shift+T` keyboard shortcut command

**Creating a Project**

A Project can be just a single file, or if you are using SYSTRAN Premium it can comprise a large collection of files containing multiple elements.

1) Select the **File»New Project** command, or click the **New Project** button on the **File** toolbar.

2) Enter Project information into the **Project Properties** dialog fields. Please note that mandatory fields are indicated in bold text.
3) Click **OK**. The new Project will display in the Corpus Explorer as **New Project**.

4) Select the **File\Save** command or click the **Save** button on the **File** Toolbar. The standard Windows **Save As** dialog will display.

5) Using the **Save As** dialog, navigate to the folder within which you want to save the Project.

6) Enter a unique file name for the Project into the **File name** field of the **Save As** dialog and click **Save**. The Project will be saved to the indicated folder as a Translation Project File (.stp Windows file extension).

### Opening an Existing Project

A Project can be just a single file, or if you are using SYSTRAN Premium it can comprise a large collection of files containing multiple elements.

1) Select the **File\Open Project** command, or click the **Open Project** button on the **File** toolbar.

2) Using the **Open** dialog, navigate to the STPM Project you want to open.

3) Click **Open**.

- The selected Project will open in the Corpus Explorer.

  -- or --

- If any of your project documents have changed since the project was last opened, STPM will offer a Source Documents **Changed** dialog from which you can choose whether you want to review and refresh those documents.

  If you select **No** or **Never ask this again** your Project will open in Corpus Explorer and all of the associated files will be as they were when you last closed your Project (though note that if you click Never ask this again you can re-
enable the checking routine using **SYSTRAN Global Options**. If you select **Yes**, though, a **Refresh Source Documents** dialog will display.

![Refresh Source Documents dialog]

By default, all changed Project documents are indicated for refresh. Confirm that only the documents you want to refresh are indicated and click **Refresh**. A **Processing Status** window will display.

Once all of the selected documents show **Refreshed** status close the **Processing Status** window by clicking the x in the upper right-hand corner.

Your Project will open in Corpus Explorer.

### Adding Components to a Project

SYSTRAN Premium Translator is required to add components to an existing STPM project.

Users running SYSTRAN Premium Translator can create and maintain STPM projects with multiple components, including Web documents obtained via an input Web address (URL). Of course, you can add and remove components from a Project at any time.

### Adding a File to a Project

STPM allows you to add files to a project, one at a time.

1) Once the Project is present in STPM, select the **Corpus|Add File** command, or click the **Add File** button on the **Corpus** Toolbar. The **Open** dialog will display.

2) Navigate to the file you wish to add to the Project and highlight it with a single click.

3) Click **Open**. A confirmation dialog will display.

4) Click **Yes**. The selected file soon displays in the Corpus Explorer as a component of the current Project.
Adding a Folder to a Project

STPM allows you to simultaneously add all of the files from a selected Windows folder, rather than adding the files one at a time.

1) Select the **Corpus|Add Folder** command, or click the **Add Folder** button on the **Corpus** Toolbar. The **Browse for Folder** dialog will display.

2) Browse to the folder whose contents you want to add to your current Project and select **OK**. The **Processing Status** dialog will display, indicating which of the files residing in the selected folder have been added to your open project in the Corpus Explorer.

3) Click the x in the upper-right corner to close the **Processing Status** dialog.

Adding a Web Page to a Project

1. Select the **Corpus|Add URL** command or click the **Add URL** button on the **Corpus** Toolbar. The **Open URL** dialog will display.

2. Enter the URL of the Web page that you want to add to the Project in the dialog and press the **Enter** key. The input Web page displays in the Corpus Explorer as a component of the current Project.

3. If desired, initiate a **Crawl** to add associated Web pages to your Project (refer to **Adding Crawl Results to a Project**).

Adding Crawl Results to a Project

Using STPM’s **Crawl** command you can also add the Web pages and files that link to a selected document.
1) Highlight the Project document for which you want to perform a crawl.

2) Select the **Corpus|Crawl** command or the **Crawl** command available in the right-click menu. The **Crawl** dialog will display.

3) Input the desired depth of the crawl into the **Crawl depth** field.

   The **Crawl depth** field is set to 1 by default, a setting that will add all files to your Project that are directly associated with your selected document. Increase the number in the field to gain deeper results (pages linked to your original document by further degrees of separation).

4) Add or delete file paths or Web page URLs for the crawl using the tools provided in the **Crawl** dialog.

5) Click the **Crawl** button. The **Processing Status** dialog will display the crawl progress, after which crawl results will display in the Corpus Explorer as components of the current Project.

---

**Working with Documents**

A key attribute of STPM is the ability to edit your source and target document files while using the application, thus allowing you to distinctly improve the quality of your translations. Also, with SYSTRAN 7 STPM you can now save or export your document files to their native file type with no loss of formatting.

**Reviewing Document Files Using Review Panes**

Review panes are the main work areas within STPM projects, offering specific sets of tools geared towards improving your source file translation. The review panes, which can be used concurrently, are all accessible via both the View menu and the Review Toolbar.

Initially, review panes display at random locations on your STPM screen. You can easily position review panes to fit your preference, though, and thereafter each time you access the panes they will display in their last-accessed position. In addition, all STPM review panes have **docking** functionality.

- Review panes are useful once the first translation action has been taken on a Project source file.
## SYSTRAN Desktop 7 Products Comparison

<table>
<thead>
<tr>
<th>Features</th>
<th>Home Translator</th>
<th>Office Translator</th>
<th>Business Translator</th>
<th>Premium Translator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translate using SYSTRAN Interactive Translator</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate selected text in any Windows application</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate Web pages in Internet Explorer and Firefox</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate Word documents</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate OpenOffice documents (ODF, ODS, ODP)</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate email in Outlook</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate PowerPoint presentations</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate Excel spreadsheets</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate PDF* files</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Translate Text, Word, RTF, PowerPoint, Excel, HTML and PDF* files using SYSTRAN Quick File Translator</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Adapt translation to your language domain(s) by automatically learning from your documents and emails using SYSTRAN Customization Wizard</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Build Translation Memories from translated documents using SYSTRAN Document Aligner</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Shortcut keys to translate selected text or a complete file, or to look up meanings for a term</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manage Translation Options and Application Settings</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manage licenses for all installed SYSTRAN products</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatically translate text when typed</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>One-click lookup of source text terms</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatically detect source file language</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatically translate linked Web pages as you navigate (fluid navigation)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spellcheck while translating</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SYSTRAN Business Domain Dictionary*</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SYSTRAN Main Dictionary</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SYSTRAN Specialized Dictionaries*</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Side-by-Side Display Mode (Internet Explorer, Firefox)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Includes Larousse Dictionary for Lookup</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Alternative Meaning Dictionary*</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create and manage dictionaries using SYSTRAN Dictionary Manager (SDM)</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>- Develop customized dictionaries based on your company or domain terminology</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>- Manage bilingual or multilingual user dictionaries</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Intuitive Coding of User Dictionary entries</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
### Features

Manage translation Projects using SYSTRAN Translation Project Manager (STPM)
- Display side-by-side source and target texts. Provide revision tools to customize translations and improve translation quality
- Translate DOC, RTF, TXT, HTML, XHTML, and PDF# files and Web pages. Proofread and post-edit
- Manage translation Projects composed of multiple files in multiple formats
- Provide additional revision tools for improving source analysis
- Import and Export linguistic data

### Capabilities

<table>
<thead>
<tr>
<th>Capabilities</th>
<th>Home Translator</th>
<th>Office Translator</th>
<th>Business Translator</th>
<th>Premium Translator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Size</td>
<td>2,000 words</td>
<td>10,000 words</td>
<td>No limit</td>
<td>No limit</td>
</tr>
<tr>
<td></td>
<td>No limit for Web browser</td>
<td>No limit for Web browser</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Dictionary Size</td>
<td>500</td>
<td>500</td>
<td>2,000</td>
<td>20,000</td>
</tr>
<tr>
<td>User Dictionary Name</td>
<td>Fixed</td>
<td>Fixed</td>
<td>Adjustable</td>
<td>Adjustable</td>
</tr>
<tr>
<td>User Dictionary Type</td>
<td>Bilingual</td>
<td>Bilingual</td>
<td>Bilingual</td>
<td>Multilingual</td>
</tr>
<tr>
<td>Normalization Dictionary Size</td>
<td></td>
<td></td>
<td></td>
<td>20,000</td>
</tr>
<tr>
<td>Translation Memory Size</td>
<td></td>
<td>10,000</td>
<td></td>
<td>40,000</td>
</tr>
<tr>
<td>Number of Translation Memories</td>
<td>1 per Language Pair</td>
<td>No Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of UDs that can be loaded per Language Pair</td>
<td>1</td>
<td>1</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Number of TMs that can be loaded per Language Pair</td>
<td></td>
<td>1</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Number of NDs that can be loaded per Language Pair</td>
<td></td>
<td></td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Number of SYSTRAN Customization Wizard configurations</td>
<td>1</td>
<td>1</td>
<td>5</td>
<td>No limit</td>
</tr>
</tbody>
</table>

* May not apply to all language pairs
* Only for French<>English, French<>Spanish, French<>Italian, French<>German, French<>Portuguese
# PDF translation does not support all PDF types (e.g., some PDF files that contain non-Western character sets, proprietary fonts, or PDF files generated from OCR).